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Troubleshooting Federal 
Child Count Reports

The Ohio Department of Education funds development of EMIS training materials 
as part of the EMIS Alliance grant. There is an expectation that ITCs will utilize these 
materials in training provided to your districts. That said, there are restrictions on 
use of the EMIS Alliance materials as follows: Materials developed as part of the 
EMIS Alliance program must be provided at no cost to your training participants. If 
you utilize the EMIS Alliance training materials – in whole or in part – you must not
charge participants a fee to attend the class where the materials are used. Likewise, 
you may not use the materials or any portion thereof in any event where a fee is 
charged to attend. Exceptions must be approved in writing by the Department of 
Education in advance of scheduling/promoting any event which may violate these 
restrictions.

Questions regarding appropriate use of EMIS Alliance materials, or requests for 
exception to the restrictions noted above, should be directed to Melissa Hennon 
[Melissa.Hennon@education.ohio.gov].

2

mailto:Melissa.Hennon@educatioin.ohio.gov


11/18/2019

2

Overview
• The Federal Child Count (FCC) 

• Includes students with disabilities who are receiving special education 
services according to their IEPs as of October 31

• Is used in determining the amount of Special Education Part-B IDEA and 
Early Childhood Special Education funds allocated to the state

• Is collected from traditional school districts, community schools and STEM 
districts through the Education Management Information System (EMIS) 
and is submitted to the US Department of Education (USDOE)

• This presentation will focus on troubleshooting the EMIS FCC 
Reports, which are generated throughout the EMIS data 
submission process
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EMIS Data Collections and the FCC Snapshot

• Collections containing the FCC report
• Beginning of Year Student (S) Collection

• SOES Beginning of Year Student (S) Collection

• Collections are scheduled to close December 20, 2019
• FCC will close when the above collections close

• There is no appeal for the FCC

4



11/18/2019

3

FCC Reports

• Level 2 Reports
• (FCCD-001) Federal Child Count Detail

• (FCCS-001) Federal Child Count Statement of Assurances

• FCC Reports are updated nightly

• Review the most recent version of the reports throughout 
the data collection process

• Submit updated EMIS data to make corrections to the 
reports
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Level 2 Reports 
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Select the Level 2 Reports link
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FCC Reports 
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Verify that filters are correct 
then select “Show Reports”

FCC Reports cont’d
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Open individual files or 
generate a zip file 
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Formatting the FCC Detail Report

• Open the (FCCD-001) Federal Child Count Detail Report
• Wrap text header row

• Freeze top row

• Expand all columns

• Apply filters

• Better yet, run your macro!
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Quick Check • Are you using the most recent 
version of the report?

• Are you able to open and format 
the CSV report to begin the review 
process?

• Can you apply filters to all 
columns? 

The Federal Child Count Detail 
Report contains student detail 
data as it pertains to the 
count. This report is critical in 
the data review and error 
correction process and should 
be carefully reviewed for 
accuracy and completeness.
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Troubleshooting 
the Federal Child Count 

Detail Report
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Troubleshooting the FCC Detail Report

The next series of slides will review data contained in the 
report including

• Student EMIS data

• Severity Codes and Numbers

• Least Restrictive Environment (LRE) Source Codes

• Federal Child Count Flag

• Status Codes and corrective actions

12



11/18/2019

7

Student EMIS Data 

• Disability Condition Code
• Review for accuracy

• Student Age Number
• Student’s age as of October 31

• Sent Reasons and IRNs
• Displays if relevant to the FCC

• FED CCT LRE Code – the code that will be used in the Federal 
Child Count
• If this is blank, the student is not included in the count 
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Severity Numbers and Codes

Severity numbers (ERR SEV NUM) are aligned with severity 
codes

• Report is sorted least severe to most severe
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ERR SEV NUM SEVERITY CODE

15 I - Informational

39 W - Warning

63 C - Critical 

79 F - Fatal



11/18/2019

8

Least Restrictive Environment (LRE) Source Codes

Columns - DIST LRE SRC CODE and DIST LRE SRC DESCR 
• Use in conjunction with the FCC Status Codes when analyzing 

report data
• 3 = Student’s age is not 3 – 21 
• 5 = No IEP Reported (Uses IENS “IEP outcome not served” as LRE)
• 7 = FN270 Override
• 8 = GE Record
• 9 = How Received = 6 

• FED CCT LRE CODE will be IE39 if age 6 or older and IENS if age 3-5
• A = Sent Reason = AU or JP 

• FED CCT LRE CODE will be IE39 if age 6 or older and IE51 if age 3-5
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Federal Child Count Flag 

Column - FED CCT FLAG 
• Y – Student included in the Federal Child Count

• N – Student not included in the Federal Child Count

• In some cases, the flag can be set to “Y” and the student has an LRE 
of IENS (IEP Complete Not Served)

• Review all students on the report regardless of flag
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FED CCT Status Codes

Columns - FED CCT STATUS CODE and FED CCT STATUS CODE 
DESCR

• Indicates the status of a student as it relates to inclusion in the 
count

• Indicates that a data issue exists or that no errors are identified 

• Data with no errors on the report should still be reviewed for 
accuracy 

• The following slides will filter on each Status Code and provide 
suggestions for error resolution

17

FED CCT Status Code FC0001

Filter on FC0001 
• On Oct 31 Student age is outside the 3-21 included range (Fatal)

• Source Code 3 - Student age is not 3 – 21 

• FED CCT FLAG - N

• View the student’s reported date of birth on the Student 
Demographic (GI) Record to confirm age

• If the student’s date of birth is incorrect, make the correction and 
submit updated EMIS data
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FED CCT Status Code FC0002

Filter on FC0002 
• Unable to translate LRE-must report FN270 element (Critical)

• Source Code 7 - FN270 Override
• or Source Code 8 - GE Record
• FED CCT Flag - N

• The FCC considers age and not grade level
• As of October 31 the student’s IEP Outcome (LRE) must agree with 

the student’s age 
• Students 3 through 5 = preschool LRE
• Students 6 through 21 = school-aged LRE
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Reporting the FN270 Element

Updated October 31 IEP Outcome Element (FN270)
• Student’s age is under 6 years old while their IEP on October 31 

has a school-aged outcome – report a preschool LRE FN270 
element

• Student’s age is over 5 years old while their IEP on October 31 has 
a preschool outcome, report a school-aged LRE FN270 element

• The current IEP outcome and FN270 values should not be the same
• When the FN270 value is reported correctly the LRE that aligns 

with the student’s age will appear in the column FED CCT LRE CODE
• When reported incorrectly the FED CCT LRE CODE column will be 

blank
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FED CCT Status Code FC0003

Filter on FC0003 
• CIEP most recent IEP - should be no disability (Warning)

• Source Code 8 - GE Record

• FED CCT FLAG - N

• Verify the CIEP event and confirm that the student’s disability code 
is being reported as ending on the date of the CIEP event

• If the student’s disability code on the Student Attributes - Effective 
Date (FD) Record is not reported as ended, make the correction 
and submit updated EMIS data

21

FED CCT Status Code FC0004
Filter on FC0004 

• No LRE reported for Oct 31 date – assigned no services LRE (Fatal) 
• Source Code 5 - No IEP Reported

• FED CCT Flag – Y (These students are included in the count) 

• FED CCT LRE CODE – IENS

• Verify the student’s special education event records as of October 31

• Verify the most recent IEP was reported to EMIS 

• Students who are age 3 to 5 with a How Received of 6 will have this 
status code. Their LRE will be manually converted to IE39 after the FCC 
snapshot by the Office of Exceptional Children prior to data being 
reported to the federal government
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ODDEX Records 

Special Education Data Tab 
• This is a great way to verify if the student’s IEP events were 

reported to EMIS
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NIEP Date Type - No IEP
Reporting an NIEP event

• NIEP is reported when services are being provided without an 
active IEP

• NIEP events can only be reported in specific situations
• 10 - Student newly transferred in; IEP adoption determination not 

complete; services being provided based on prior IEP

• 11 - IEP expired; new IEP not in place; services being provided based on 
prior IEP

• 12 - IEP current, but not reported to EMIS in prior collection; services 
provided based on current IEP

• NIEP cannot be used prior to an Initial IEP being written and 
services provided
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FED CCT Status Code FC0005

Filter on FC0005
• Student does not meet inclusion filter in this district (Warning)

• Source Code 5 - No IEP Reported – verify if special education events need to 
be reported for this student

• or Source Code 7 - FN270 Override
• or Source Code 8 - GE Record
• FED CCT Flag - N

• Review Student Standing (FS) Record coding for accuracy
• Refer to the Federal Child Count Report Explanation, section “Include 

in USDOE Count” 
• Open enrolled in and court placed in students can have this status at 

the educating district
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Multiple District Tie Breakers

1. Student counts where Reporting IRN = District of Residence IRN

~OR~ counts where Reporting IRN is reporting a How Received 
code of M (Community School) or K (STEM District)

2. If entities are claiming the student in the same way (as above),
then the student is included at the entity with the later 
Admission Date

3. If entities are claiming the student in the same way as in number 1 
and reporting the student with the same admission date, then 
the student will not count for any district 
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FED CCT Status Code FC0006
Filter on FC0006 

• Student counting in alternative district - does not count in your 
district (Warning)
• Source Code 5 – No IEP Reported - verify if special education events need to 

be reported for this student
• or Source Code 7 - FN270 Override 
• or Source Code 8 - GE Record
• or Source Code 9 - How Received = 6
• or Source Code A - Sent Reason AU or JP
• FED CCT Flag - N

• Student counts at the IRN in the FED CCT ALT IRN column
• Review data in ODDEX to compare how data is being reported
• Communicate with the alternative district to determine how this 

student should be reported

27

FED CCT Status Code FC0007

Filter on FC0007
• Student excluded -conflict in where student should count (Fatal) 

• Source Code – 7 FN270 Override
• Or Source Code – 8 GE Record
• FED CCT Flag - N

• Could not determine where this student should count, so the student 
will not be counted at either entity

• Review data in ODDEX to compare how data is being reported by both 
entities

• Communicate with the other entity to determine how this student 
should be reported
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FED CCT Status Code FC0008

Filter on FC0008
• No errors identified in ODE processing (Informational) 

• Source Code 7 – FN270 Override 
• or Source Code 8 – GE Record
• or Source Code 9 – How Received = 6
• or Source Code A – Sent Reason = AU or JP
• FED CCT Flag - Y

• Data for the students should still be reviewed for accuracy
• Apply filters to verify elements such as disability conditions and LREs
• District staff can be very helpful in verifying data accuracy and 

completeness
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Quick Check
• Have all status codes been 

reviewed and all reporting issues 
corrected? 

• When corrections have been 
made in the student information 
system (SIS), has that updated 
data been submitted to EMIS?

• Based on inclusion criteria are all 
of your special education students 
being counted correctly?

The Federal Child Count Detail 
report will display students 
who are and who are not 
included in your count. The 
report will also indicate 
students with issues 
preventing them from being 
included. Check this report 
often as it can be effected by 
another entity’s EMIS 
reporting. 
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Troubleshooting 
the Federal Child Count Statement of 

Assurances Report

31

Open the FCC Statement of Assurances Report 

32

Format the report 
by wrapping the 
text in the header 
row and expanding 
all columns 
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Understanding Statement of Assurances 

• The report includes
• only students who have a FED CCT Flag = Y
• all students age 3 to 5 in the first category
• students age 6 to 21 in each disability specific category

• Using the above criteria the next series of slides will match 
the FCC Detail Report against the FCC Statement of 
Assurances Report 

• When you are told that the counts on this report are 
incorrect, filtering allows you to show which students are 
included or not included
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Filter on FCC CCT Flag 

34

Select Y on the 
FED CCT Flag Filter on 
the FCC Detail Report These are the students 

who are included in 
the Statement of
Assurances Report
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Filter on Student Age Number 

35

Select ages 3, 4 and 
5 on the FCC Detail 
Report

These students are
included in the 3, 
4, and 5 year olds 
with any disability 

Matching Data Between Reports

36

From the filtered students on the FCC Detail Report, select 
a range of cells and see the “count” appear at the bottom 
of the spreadsheet. This will match the count on the 
Statement of Assurances. 
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Arrange All 

37

When two spreadsheets 
are open at the same 
time, from the View tab 
select “Arrange All” and 
then “Vertical” 

Arrange All cont’d
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“Arrange All” allows 
both spreadsheets to 
be viewable at the 
same time
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Change the Student Age Filter

39

Change the filter for the Student 
Age Number column to include 
all ages except 3, 4, and 5

Leave the FED CCT Flag 
Column filter set to 
show only Y values 

Add a Third Filter
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Add a third filter in 
the DISAB CNDTN 
CODE column

Select one disability 
code at a time
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Match the Data Between the Reports 

41

1. From the filtered students on the 
FCC Detail Report, select a range 
of cells and see the “count” appear 
at the bottom of the spreadsheet. 

2. This will match the count on 
the Statement of Assurances. 

Quick Check • Can you match the data between 
the two reports using filters?

• Are you seeing the numbers of 
students that you were expecting? 

• Has this data been shared with 
others in your district?

The Federal Child Count
Statement of Assurances 
Report is derived from the 
same data that is on the FCC 
Detail Report. Using filters, 
you can match the data 
between the reports. The 
Statement of Assurances is 
sometimes requested by 
auditors.
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Summary

• The FCC Reports contain both data to verify and issues to 
correct

• Some issues can be corrected and some are simply stating 
the fact that the student cannot be included in the count 

• Work with district staff to verify that the data is both correct 
and complete

• “No errors” does not necessarily mean that your data is 
accurate
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Resources

• Federal Child Count Detail Report and Federal Child Count 
Statement of Assurances Report Explanation
• ODE Home > Data > EMIS > Documentation > EMIS Validation and 

Report Explanations 

• EMIS Manual 
• ODE Home > Data > EMIS > Documentation > EMIS Manual

• Your district staff

• Your ITC
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Questions?


